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Important information for your
interactive flat panel

WARNING

Failure to follow the installation instructions shipped with your SMART product could result in
personal injury and product damage which may not be covered by your warranty.

Do not open or disassemble the SMART product. You risk electrical shock from the high
voltage inside the casing. Opening the casing also voids your warranty.

Do not stand (or allow children to stand) on a chair to touch the surface of your SMART
product. Rather, mount the product at the appropriate height.

To reduce the risk of fire or electric shock, do not expose the SMART product to rain or
moisture.

If your SMART product requires replacement parts, make sure the service technician uses
replacement parts specified by SMART Technologies or parts with the same characteristics
as the original.

Ensure that any cables extending across the floor to your SMART product are properly
bundled and marked to avoid a trip hazard.

Do not insert objects inside the cabinet ventilation holes, because they could touch dangerous
voltage points and cause electric shock, fire or product damage which may not be covered by
your warranty.

Do not place any heavy objects on the power cable. Damage to the cable could cause shock,
fire or product damage which may not be covered by your warranty.

Use only extension cords and outlets into which this product’s polarized plug can be fully
inserted.

Use the power cable provided with this product. If a power cable is not supplied with this
product, please contact your supplier. Use only power cables that match the AC voltage of the
power outlet and that comply with your country’s safety standards.

If the glass is broken, do not touch the liquid crystal. To prevent injury, handle glass fragments
with care when disposing of them.
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IMPORTANT INFORMATION FOR YOUR INTERACTIVE FLAT PANEL

Do not move or mount the interactive flat panel by connecting rope or wire to its handles.
Because the interactive flat panel is heavy, rope, wire or handle failure could lead to personal
injury.

To prevent personal injury, do not attempt to mount or carry the interactive flat panel using your

own strength. Instead, use a lifting device with the included M12 attachable eyebolts. The
eyebolts are not post-installation hardware.

Use only VESA®-approved mounting hardware.

Lamps in this product contain mercury. Handle lamps with care. Comply with local, state or
federal law when recycling or disposing of lamps from this product.

Disconnect all power cables for your interactive flat panel from the wall outlet and seek
assistance from qualified service personnel when any of the following occurs:
o The power cable or plug is damaged

o Liquid is spilled into the interactive flat panel

[e]

Objects fall into the interactive flat panel

o

The interactive flat panel is dropped

[e]

Structural damage such as cracking occurs

(¢]

The interactive flat panel behaves unexpectedly when you follow operating instructions

CAUTION

Before you clean your SMART product, shut down or disconnect the computer. Otherwise,
you may scramble the desktop icons or inadvertently activate applications when you wipe the
screen.

Avoid setting up and using the SMART product in an area with excessive levels of dust,
humidity and smoke.

Make sure an electrical socket is near your SMART product and remains easily accessible
during use.

The external power supply needs to meet the Limited Power Source (LPS) requirements of
CSA/UL/IEC/EN 60950-1, when required.

smarttech.com/kb/155317



IMPORTANT INFORMATION FOR YOUR INTERACTIVE FLAT PANEL

e This SMART product should be used only with European TN and TT power distribution

systems.

It is not suitable for older, IT-type power distribution systems found in some European
countries. "This system (IT-type) is widely used isolated from earth, in some installations in
France, with impedance to earth, at 230/400V, and in Norway, with voltage limiter, neutral not
distributed, at 230V line-to-line." (IEC 60950:1999)

Contact qualified personnel if you’re uncertain of the type of power system available where
you're installing your SMART product.

You must connect the USB cable that came with your SMART Board® interactive flat panel to
a computer that has a USB compliant interface and that bears the USB logo. In addition, the
USB source computer must be compliant with CSA/UL/EN 60950 and bear the CE mark and
CSA and/or UL Mark(s) for CSA/UL 60950. This is for operating safety and to avoid damage to
the SMART Board interactive flat panel.
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CHAPTER 1

About your interactive flat panel

Commercial-grade, touch-enabled flat panel

Your SMART Board 8070i interactive flat panel features SMART's proprietary DViT®

(Digital Vision Touch) technology on an LCD screen which enables you to select, write and erase on
the interactive surface. It enables you to do everything you can do at your computer—open and close
applications, conference with others, create new documents or edit existing ones, visit websites,
play and manipulate video clips and more—just by touching the interactive surface. Two users can
also draw on the interactive surface at the same time, and you can use an array of gestures within
applications.

You can also write over any application in digital ink using a pen tray pen or your finger, and then save
these notes for future reference and distribution.

Elegant, sophisticated design
The professional design and crisp, eye-catching visuals of the SMART Board 8070i interactive flat
panel make it perfect for any high-end workspace.

Software

To use all the features of your interactive flat panel described in this guide, go to
smarttech.com/downloads and ensure that you have the latest version of SMART software and
SMART Product Drivers installed on your computer.

Dual sketch capabilities
Two people can each pick up a pen and draw on the interactive surface at the same time, providing a
higher degree of interactivity.

SMART Ink™

SMART Ink enables you to write and draw in digital ink over open applications, files, folders,
websites and any other open window on your computer. When you write outside the open windows on
your computer, a SMART Ink Note appears and you can write inside the note.

When you open an application that has its own ink tools, you can turn off SMART Ink, and then use
the application's ink tools to write in the content.

For more information, see the SMART Ink user’s guide for Windows® operating systems
(smarttech.com/kb/170191) or SMART Ink user's guide for Mac OS X operating system software
(smarttech.com/kb/170192).
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CHAPTER 1

About your interactive flat panel

Touch and gestures

You can perform mouse functions with your finger, and write and erase digital ink with a pen tray pen
or the eraser. The object awareness feature enables you to pick up a pen, and then write, select or
erase without replacing the pen.

Durable surface
The SMART Board 8070i interactive flat panel features a hardened glass screen.

Front view
The front of your interactive flat panel includes the LCD screen, the cameras and reflective tape
channel, the pen holders with the pens, the eraser holder with an eraser and the color select module.

Cameras Cameras

(G ) C )
e
Fror;;cr:g; trol Pen Eraser \ Pen
Color select module
LCD screen

The screenis 61" W x 34 1/4" H (154.9 cm x 87.2 cm), with a 70" (178 cm) diagonal, 16:9 format.
For information on cleaning your LCD screen, see Cleaning the screen on page 58.

Camera and reflective tape channel

The interactive flat panel screen is bordered by a channel that contains reflective tape. Each corner

has a camera that tracks finger and pen positions across the screen. For information on cleaning your
camera windows and reflective tape, see Cleaning the screen on page 58.
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CHAPTER 1

About your interactive flat panel

'Y CAUTION

o Do not damage or remove the reflective tape.
o Keep the reflective tape dry.

IMPORTANT

o Do not attach items such as adhesive notes to the screen because they will interfere with the
cameras.
o Do not place anything in the channel because it will interfere with the cameras.

Pen and eraser holders
The bottom bezel contains magnetic holders for two pens and an eraser. Removing a pen or the
eraser from the holders activates it and enables you to either draw or erase digital ink.

'Y CAUTION

When returning the pen or eraser to the magnetic holder, ensure that it is centered on the holder to
prevent the pen or eraser from falling and potentially being damaged.

Color select module
The color select module enables you to access the help function, open the on-screen keyboard,
select pen color, activate the right-click and orient the interactive flat panel.

® n
Jn-screen | \ \
Help keyboam Pen color buttons Right-Click
Orientthe
interactivefiat panel
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CHAPTER 1

About your interactive flat panel

Front control panel

The front control panel contains the volume
control, mute, input and power buttons, as
well as the status light and infrared remote
control sensor.

IMPORTANT

Do not cover or block this area or you could
have reduced use of the infrared remote
control.

In normal use

e The volume, mute and input buttons are
blue.

« The power button is green.
« The status light is green.

For information on diagnosing issues using
the front control panel lights, see Diagnosing
blank screen issues using the front control
panel lights on page 63.

Infrared remote control

\

[5{ [m e D

|

= o —

Infrared remote

Violume
corntna
'&.T_,-f'
/_..--"/#
Mute f'-@
Input
/’/ i
Power | O
System — |L_
status light d

control sensor

The infrared remote control enables you to turn on and turn off your interactive flat panel, change the
input source, adjust the volume, access the on-screen menu and more. For more information on the

infrared remote control, see Using the infrared remote control on page 31.
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CHAPTER 1

About your interactive flat panel

Left side view

The left side of your interactive flat
panel has the menu control panel
and the side terminal panel.

Menu control panel

i

USB receptacle
for a USB drive

=
80

)

USB B receptacle for
guest laptop
(USB 3)

HDI video input
for guest laptop

(HDMI 2) ~_

azoie

Menu control panel

The menu control panel enables you to access the on-screen display menu to adjust display and
audio settings. For more information on the on-screen display menu, see Adjusting video settings
with the on-screen display menu on page 75.

USB receptacle
The USB receptacle takes a USB type A connector, such as a USB memory drive. For more

information on this receptacle, see Using the USB receptacle on page 47.

NOTE

You can disable this USB receptacle so the room computer cannot access it. For instructions, see
Disabling the USB receptacle on the side terminal panel on page 22.

Side terminal panel
The side terminal panel has USB and HDMI receptacles for connecting a side laptop. For more
information on this terminal panel, see Connecting a side laptop on page 51.
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CHAPTER 1

About your interactive flat panel

Back view
The back of the interactive flat panel includes the bottom terminal panel, the inside terminal panel,the
audio connection terminal panel and the appliance (for SMART Board 8070ie-SMP interactive flat

panels only).

IMPORTANT

Connect all required cables before you wall-mount your interactive flat panel. Some connectors
could be inaccessible after wall mounting.

Inzide
terminal
pane

Audio connechion

Bottom terminal panel —— panel(facesinside
terminal panej)
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CHAPTER 1

About your interactive flat panel

Bottom terminal panel
The bottom terminal panel contains the main power switch and several connections, including both

touch control connections and connections for auxiliary input and output devices, such as DVD
players, Blu-ray ™ players and VCRs.

== [/ USB 1
DisplayPort = “"m,,@_ : USB 2
HDMI 1 el I
Main power
switch DVI-D RGB/HV OUtV'd t &
’(B‘j\j’g)“ RCA video
| input

< ..
| Audio in

[ N
oL % sEme [DOOOUO 90 peeg | 1,23

7
AC power VGA / /
inlet ~/ S-Video in
AC power outlet for  5-BNC connectors Video in .
designated SMART  forthe RGB/HvY  (BNC and RCA)  Audio out
products only

'S cAuTION

The AC power outlet is designated for a component of the SMART Board 8070ie-SMP interactive
flat panel. Use this power outlet only as designated by documentation for that system. Using this
power outlet for other items could damage the interactive flat panel.
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CHAPTER 1

About your interactive flat panel

Inside terminal panel

The inside terminal panel is on the left side of
the interactive flat panel and contains the touch
control USB connections and the room control
input and output.

[~ Room controd
input

-.-
USB 1 for the H‘“‘H Room control
roomcomputer output

\\ -
USB 2 for the R
guestiapton \ -

connection
Audio terminal panel - ™
This panel contains the speaker wire connections and the
wired remote control receptacles.
Speakerwine
IMPORTANT s
Do not connect RCA or 3.5 mm speaker plugs to the
wired remote control receptacles. The infrared remote
control is disabled while anything is inserted in these
receptacles.
Wired
@ @ remote
control
receptacies
s o
Appliance

Your SMART Board 8070ie-SMP interactive flat panel appliance is attached to the back of the
interactive flat panel.

The appliance comes with SMART Product Drivers and the SMART Meeting Pro™ application
installed (see About the SMART Meeting Pro application on page 48).
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CHAPTER 1

About your interactive flat panel

Other components for the SMART Board 8070i-SMP interactive flat

panel
The following components are included with the SMART Board 8070i-SMP interactive flat panel.

SMART GoWire™ auto-launch cable
Enables you to use SMART Product Drivers and SMART Meeting Pro software without installing
them on your computer. For more information, see Using a SMART GoWire cable on page 50.

CAT 5 USB extender
Extends a USB connection between your computer and the interactive flat panel. For more
information, see the documentation included with the CAT 5 USB extender.
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Chapter 2

Installing your interactive flat
panel

Environmental reqUIiremMents L 11
Wall-mounting your interactive flat panel ... .. 12
Important mounting considerations for trainedinstallers ........ ... ... .................... 13
Choosing a mounting location ... il 14
Choosing a mounting height ... L 14

You require a team of professional installers equipped with a lifting device to install your
SMART Board 8070i interactive flat panel.

This chapter provides additional considerations and details for installing your interactive flat panel.

IMPORTANT

Because the receptacles might not be accessible after wall-installation, consider connecting cables
for speakers, computers and peripheral devices while the interactive flat panel is still in its
packaging or is suspended from a lifting device. For more information, see Connecting computers
and peripheral devices on page 15.

Before installing your interactive flat panel, review the following environmental requirements. For
more detailed information, see SMART Board 8070i and 8070i-SMP interactive flat panel
specifications (smarttech.com/kb/155318) or SMART Board 8070ie-SMP interactive flat panel with
appliance specifications (smarttech.com/kb/170078).

Environmental requirement Parameter

Power requirements .2A-3.7A at 100V-240V AC, 50 Hz—60 Hz

11 smarttech.com/kb/155317
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CHAPTER 2

Installing your interactive flat panel

Environmental requirement Parameter

Power consumption at 77°F Typically up—530 W (brightness at 70% and volume at 40),
(25°C) maximum 580 W (brightness and volume at maximums)
Operating temperature 41°F to 95°F (5°C t0 35°C)

Storage temperature -4°F to 140°F (-20°C to 60°C)

Humidity 5% to 80% relative humidity, non-condensing

Ventilation Maintain a 4" (10 cm) ventilation area around your interactive flat

panel to enable its cooling fans to operate. Do not store or
operate your interactive flat panel in dusty environments
because dust could interfere with the product’s ventilation and
cooling.

Water and fluid resistance ¢ Intended forindoor use only. Doesn’t meet any salt-spray
or water ingress requirements.

o Don't pour or spray liquids directly onto the interactive flat
panel or any of its sub-components. These liquids might
get into areas where they could damage sensitive
electronic components. Refer to page 58 for detailed
instructions on cleaning your interactive flat panel.

Use ateam of trained, professional installers equipped with a lifting device to install your interactive
flat panel.

N WARNING
o Improper installation can result in personal injury or product damage.

o Yourinteractive flat panel weighs 262 Ib. (119 kg). Refer to local building codes to ensure your
installation area can support this weight.

'Y CAUTION

Do not allow the weight of the interactive flat panel to rest on the color select module because it is
not designed to support product weight. Attach other components while the interactive flat panel is
either still in its packaging or suspended from a lifting device to prevent the weight of the interactive
flat panel from damaging the color select module.
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CHAPTER 2

Installing your interactive flat panel

IMPORTANT

Save all product packaging so that it is available if you need to transport your interactive flat panel.
If your original packaging is not available, you can purchase new product packaging from your
authorized SMART reseller (smarttech.com/where).

Important mounting considerations for trained installers
Consider the following when mounting the interactive flat panel on a wall:

¢ Attach the included M12 eyebolts and washers to assist in mounting, and remove them after you

13

wall-mount the interactive flat panel.

FN WARNING Eyebolt ?

Do not attempt to mount or carry the interactive
flat panel using your own strength because it
could fall and cause personal injury. Attach a
lifting device to the included M12 eyebolts to lift
and carry the interactive flat panel.

Y cAuTION

Hand-tighten the M12 eyebolts. If you over-tighten the eyebolts and damage the threads, you
will be unable to remove the eyebolts.

Plan your workflow to include cabling because some cable connection points might not be
accessible after installation.

IMPORTANT

Attach the speakers and connect the speaker wires to the interactive flat panel before you
wall-mount it. For more information, see Installing the speakers on page 16.

To mount the interactive flat panel on a wall, you require a standard VESA 400 mm x 400 mm
mounting plate (not included).

Use M8 screws to fasten the wall bracket. The screws must be 14—15 mm long plus the
thickness of the bracket and the washer.

The recommended fasten force is 99.57-121.70 in-Ib. (11.25-13.75 N-m).

Refer to the instructions included with the mounting equipment for more detailed information.

smarttech.com/kb/155317
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CHAPTER 2

Installing your interactive flat panel

Choosing a mounting location
Consider the following when you select a location for the interactive flat panel:

The wall must be strong enough to support the interactive flat panel and the mounting equipment.
The interactive flat panel weighs 262 Ib. (119 kg).

Do not install the interactive flat panel in a location where a door or gate could hit it.

Do not install the interactive flat panel in an area where it will be subjected to strong vibrations or
dust.

Do not install the interactive flat panel near where the main power supply enters the building.

Ensure adequate ventilation or provide air conditioning around the interactive flat panel so that
heat can flow away from the unit and the mounting equipment.

If you mount the interactive flat panel in a recessed area, leave at least 4" (10 cm) of space
between the interactive flat panel and the recess walls to enable ventilation and cooling.

Choosing a mounting height
Consider the general height of your user community when your choose the mounting height for the
interactive flat panel.

14
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Chapter 3

Connecting computers and
peripheral devices

Installing the SPEaKErS . .. 16
Connecting aroom control System ... 17
Connecting computers to yourinteractive flatpanel ..._......... ... .. ... 18
Interactive flat panel touch control and video input connections ... ... ... ... ... 18
Connecting to power and your room computer ... 19
Room computer connection diagram .. ... . . 19
Installing a guest laptop connection .. ... 20
Guest laptop connection diagram ... 21
Disabling the USB receptacle on the side terminal panel ... ... ... ... 22
Connecting peripheral devices to your interactive flat panel ... .. . ... 23
Bottom terminal panel . ... ... il 23

This chapter includes information on connecting your interactive flat panel to computers and other
peripheral devices.

IMPORTANT

Because the cable connection points might not be accessible after wall-installation, consider
connecting these devices while the interactive flat panel is suspended from the lifting device.
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CHAPTER 3

Connecting computers and peripheral devices

Your interactive flat panel comes with two 15 W speakers.

Speaker mounting holes

% (both sides)

Speaker wire
connections

i EE,

EE,
Wired remote

control connections
Wire run to the Q]
left speaker

To install the speakers

1. Attach the speakers to the speaker mounting holes on the side of the interactive flat panel with
the included screws.

2. Connect the speaker wires to the speaker wire connections.

IMPORTANT

Do not connect the speakers to the wired remote control 3.5 mm jacks. These are not audio
connections. The remote control is disabled while anything is inserted into these jacks.

3. Runthe speaker wire for the left speaker (when viewed from the back of the interactive flat
panel) below the bottom terminal panel and secure it with the included small clamps.
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CHAPTER 3

Connecting computers and peripheral devices

You can control your interactive flat panel from a room control system.
To connect your interactive flat panel to a room control system

Connect an RS-232 cable from the room control input on the inside terminal panel of the
interactive flat panel to the serial output on your computer or room control system.

IMPORTANT

Do not use a null modem cable. Use only a standard RS-232 cable.

s \\
i \‘ .J ) ‘\\
I T T Room control
\\\?«:\ input
\‘.“\\\\\\
: N gl Room control
NS 25|
% u TX {@] output
v )

N |
= =
I
o = - ~

1 S
e g

) a— . \

. \‘i\‘\ | b
— W \

Inside terminal
panel

For more information about setting up and programming an RS-232 connection, see Remotely
managing your SMART Board 8070i interactive flat panel (smarttech.com/kb/160469).
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CHAPTER 3

Connecting computers and peripheral devices

You can connect up to three computers simultaneously to your interactive flat panel:
e Computer 1 (an installed room computer) connected to USB 1 and VGA 1
e Computer 2 (a guest computer) connected to USB 2 and VGA 2

¢ A guest laptop connected to USB 3 and HDMI 2 connector

NOTE

This document describes the default USB and video connections. To customize the USB and video

mapping, see Configuring the video and touch input for your SMART Board 8070i interactive flat
panel (smarttech.com/kb/170065).

To USB 3
HS'XZ 5 To USB 1
L~ and
] / VGA
Side laptop NI Room
5.\’ I.’ computer
[
ToUSB2 | 1
= and |\
‘\\ - RGB/HV )

/ WMB-SBID
Wire

management
bundle

\,

Interactive flat panel touch control and video input connections
The following table shows which touch control USB connection corresponds with which video input
for each computer connection.

Touch control Video input Installation steps

Room computer USB 1 (inside panel) VGA page 19
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CHAPTER 3

Connecting computers and peripheral devices

Touch control Video input Installation steps
Guest laptop connection ~ USB 2 (inside panel) RGB/HV page 20
Side laptop connection USB 3 (side terminal panel) HDMI 2 page 51

NOTE

A wire management bundle (part number WMB-SBID) for the guest laptop connection is available
from your authorized SMART reseller. This 16" (5 m) bundle includes a USB cable and a RGB/HV
to VGA video cable.

Your room computer is the default computer for your interactive flat panel. Connect this computer to
your interactive flat panel with a VGA cable and a USB cable.

Room computer connection diagram

Lol “‘

145 " j : UsE 1
P "1 :

= T /

<SSl A 8]
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CHAPTER 3

Connecting computers and peripheral devices

To connect your interactive flat panel to power and your room computer

1. Connect the included VGA cable from computer 1 to the VGA receptacle on the bottom terminal
panel.

2. Connect the included USB cable from the USB 1 receptacle on the inside terminal panel of the
interactive flat panel to a USB receptacle on the computer.

3. Connect the included power cable from the AC IN connector on the bottom terminal panel to a
power outlet.

4. Connect the power cable from your computer to a power outlet.
5. Tumn on your computer.

6. Turn on the main power switch on the bottom terminal panel, and then press the Power button b
on the front control panel.

7. Using the remote control or the Input button B] on the front control panel, set the interactive flat
panel’s input source to VGA.

You can install cabling that enables you to connect a second computer to your interactive flat panel
from another location in the room, such as on a conference table. By installing this connection, you
make use of connection points that might not be accessible when your interactive flat panel is
wall-mounted.

You require a USB cable and a RGB/HV to VGA cable to install the guest laptop connection. You can
purchase a wire bundle that includes these two connectors from your authorized SMART reseller.
You may install these cables and run them through floors or walls to a nearby table. Refer to the
interactive flat panel specifications document for ordering information.

Alternatively, your users can connect a laptop to the side terminal panel using the more accessible
USB receptacle and HDMI input. For more information, see Connecting a side laptop on page 51. For
a diagram of the various computer options, see Connecting computers to your interactive flat panel
on page 18.

N WARNING

Ensure that any cables extending across the floor to your SMART product are properly bundled and
marked to avoid a trip hazard.
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NOTE

You do not require a laptop to install this cabling.

Guest laptop connection diagram
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To setup the guest laptop connection location

1.

Connect a USB cable to the USB 2 receptacle on the inside terminal panel, and then run the
cable to the laptop connection location, such as beside the interactive flat panel oron a
conference table.

Connect a 5-BNC to VGA video cable to the RGB/HV interactive flat panel connection on the
bottom terminal panel, and then run the cable to the remote connection location as above.

@
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RO AR GOOOWO 0@ 0008

Red Blue Yellow
Green White

3. Bundle and cover the cables as appropriate to avoid a trip hazard.
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To connect and use a guest laptop using this installed connection, see Connecting a guest laptop on
page 49.

You can connect a USB drive or other USB device to the USB receptacle on the side terminal panel
of your interactive flat panel, and then access the device from the room computer. For more
information, see Using the USB receptacle on page 47.

You can also disable this USB receptacle so that it doesn’t access any of the computers connected

to your interactive flat panel.

'S cAuTION

Disconnect the power supply for your interactive flat panel before you disable the USB receptacle.

To disable the USB receptacle

1.

22

Locate the oval cut-out on the back of your interactive flat panel. It’s at the same height as the
USB receptacle and very close to the receptacle.

Rotate the top of the cut-out using needle-nose pliers, and then grasp the bottom edge of the cut-
out with the pliers.

Pry the cut-out away from your interactive flat panel.
You can see a black jumper on the circuit board inside the panel.

Pull the black jumper off of the circuit board with the pliers.

"N cAuUTION

To prevent damage to the circuit board, do not touch the circuit board with the pliers.

IMPORTANT

You can install the jumper again to enable the USB receptacle.
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Connect peripheral devices to the bottom terminal panel.

'S cAuTION
The AC power outlet is designated for a component of the SMART Board 8070ie-SMP interactive
flat panel with appliance. Use this power outlet only as instructed by that product’s documentation.

Bottom terminal panel

RYE-ENa ’
i | By 9 .
L SN USB 1
DisplayPort <, A USB 2
HDMI 1 . ‘ '
Main power
switch DVI-D RGB/HV OutVideo = N
(BNC) RC£ video
put
A .
OOV eg ° seelAudoin
OOOOOID 9 @Q 1,2,3

(

N
[/ o]

S-Video in
Video in

7
AC
power VGA

inlet
AC power outlet for 5-BNC connectors .
designated SMART  for the RGB/Hy  (BNCand RCA)  Audio out

products only
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To connect a peripheral device
1. Tum off the interactive flat panel and the peripheral device.

2. Connect the peripheral device’s input cables to the appropriate connectors on the bottom
terminal panel.

NOTE

You can secure these cables with the included large clamps.

3. Turn on the interactive flat panel, and then tumn on the peripheral device.
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Installing SMART Meeting Pro software . ... L 26
Installing SMART Notebook software ... 26

IMPORTANT

If you already have SMART Meeting Pro software or SMART Notebook™ collaborative learning
software installed on your computer, ensure your computer has SMART Product Drivers 11 or later
installed. For more information, see Updating SMART Product Drivers on page 55.

You need to install SMART software on the computer that's connected to your interactive flat panel in
order to use the interactive flat panel. You can install either SMART Meeting Pro software or
SMART Notebook software.

SMART Board 8070i-SMP interactive flat panels also include a SMART GoWire auto-launch cable
that provides the features of SMART Meeting Pro software without installing the software on your
computer. For more information about using the SMART GoWire auto-launch cable, see Using a
SMART GoWire cable on page 50.

NOTE

For laptops that are only occasionally used for your interactive flat panel, you can use a
SMART GoWire cable instead of installing SMART Meeting Pro software.

Once you install SMART Notebook software or SMART Meeting Pro software on the computer that's
connected to your interactive flat panel, you have touch control of that computer's desktop. You can
open files, move icons and write or erase digital ink using the included pens and eraser.
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You can download and install SMART Meeting Pro software from the SMART website.

IMPORTANT

Register your product at smarttech.com/registration so that you can obtain a software product key
which is required for activation.

To download SMART Meeting Pro software
1. Go to smarttech.com/downloads.
2. Scroll tothe SMART Meeting Pro software section.
3. Click Choose a version, and then select the version that you require.
4

Follow the on-screen instructions to save the executable file to your desktop.

To install SMART Meeting Pro software
1. Double-click the executable file.

2. Follow the on-screen instructions.

Install SMART Notebook software from the included DVD (SMART Board 8070i interactive flat
panels only) or from smarttech.com/downloads.

IMPORTANT

Connect to the Internet before you install SMART software so that you can obtain a software
product key (smarttech.com/registration) and download software updates.

To install SMART Notebook software
1. Place the included software DVD in your computer's DVD tray.
The installation wizard appears.

2. Follow the on-screen instructions. You'll be prompted to enter your product key. You can register
your interactive flat panel at smarttech.com/registration to receive your product key.
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3. Click the SMART Board icon |.*]in the notification area (Windows operating systems) or the
Dock (Mac OS X operating system software), and then select Check for Updates and
Activation.

The SMART Product Update window appears.

4. Follow the on-screen instructions to update your SMART Notebook software to the latest
version.
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Turning on and turning off your interactive flat panel ... ... . 30
Using the infrared remote control ... ... 31
Installing batteries in the remote control ........... ... . ... il 31
Infrared remote CONtrOl SENS O ... . 32
Infrared remote control buttons . ... .. .. il 33
Getting started with your SMART Board interactive flatpanel ............. . ......................... 35
AbOUt SIMA R T INK 35
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SMART Notebook software ... . ... 36

SMART Meeting Prosoftware . ... ... .. e 36

Writing or drawing in digital inK ... L 36
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Changing pen SettiNgs ... L 37
Using Locked InK Mode .. ... 38
Erasing digital iNK . ... .. 38
Changing eraser settiNgs ... . . 39
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BrOWSING .. ... 43
Playing audio files on your interactive flat panel .. .. 46
Using the USB receptacle ... .. il 47
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About the SMART Meeting Pro application ... .. 48
Getting started with the SMART Meeting Pro application ........ ... ... 48

This chapter includes information on how to use your interactive flat panel, turn on and turn off your
interactive flat panel, control your computer by touching the screen, use the remote control and more.
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To turn on your interactive flat panel

1. Turn on your computer.

2. Press the Power button (!) on the front control panel.

You can also press the POWER ON button on the remote control.
Your computer's logon screen or desktop appears on your interactive flat panel.
IMPORTANT

If the power button light on the front control panel is off, either the interactive flat panel is not
plugged in or the main power switch on the bottom terminal panel is turned off. To find the main
power switch, see Back view on page 7.

To turn off your interactive flat panel

1. Turn off your computer.

2. Press the Power button (!) on the front control panel.

You can also press the STANDBY button on the remote control.
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The infrared remote control enables you to turn on and turn off your interactive flat panel, change the
input source, change the volume and more. You can also use the remote control to open the on-
screen menu and then change the interactive flat panel’s settings.

If the remote control doesn’t respond, see Resolving remote control issues on page 72.

'Y cCAuUTION
¢ Do not subject the remote control to strong shock.
o Keep the remote control away from liquids. If it gets wet, wipe it dry immediately.
o Do not expose the remote control to heat or steam.

o Do not open any part of the remote control other than the battery compartment.

IMPORTANT

The remote control system does not function when strong light strikes the remote control sensor or
when there is an object between the remote control and its sensor.

Installing batteries in the remote control
Your remote control requires two 1.5V AA batteries.

/N WARNING

To reduce the risk associated with leaking batteries:
o use only AA type batteries
e do not mix used and new batteries

o orient the battery’s plus (+) and minus (-) terminals according to the markings found on the
remote control

o do not leave the batteries in the remote control for an extended period

o do not heat, disassemble, short or recharge the batteries, or expose them to fire or high
temperature

o avoid eye and skin contact if batteries have leaked

o dispose of exhausted batteries and product components in accordance with applicable
regulations
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To install batteries in the remote control
1. Press the tab on the underside of the remote control, and then slide it to open the cover.
2. Remove the batteries if they are present.

3. Insert two new 1.5V AA batteries in the remote control. Ensure the + and - markings on the
batteries align with the markings in the remote control.

4. Replace the cover.

Infrared remote control sensor
The infrared remote control sensor is

located on the front control panel. It
enables you to control your interactive flat
panel from an angle of 30° and within a
distance of 23' (7 m) using the included
remote control.

IMPORTANT

The remote control might not function
when the infrared remote control sensor
is blocked or when it is in direct sunlight
or strong lighting.
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Infrared remote control buttons ( N
The remote control enables you to access on-screen menus and 1 C1 ) (())
change display and input settings. .
g y g ) @ ﬁ & %
Use the remote control's POWER ON button turn on your &-ﬂ"/
interactive flat panel and the STANDBY button to turn it off. 3 4 ) ﬁ “ - 5
EBEEE
Use the remote control’s input buttons to change input sources [« W s N 6 |
o 6
when switching between the room computer and guest laptops. (s N o |
B /R 7
8 DISPLAY & 9
I, i
13 AUTO! ‘ 13
10 L) o, G —11
17 VOL CH |2
N iia BB
15 16
NS CAPTUR; = 1 8
19 - 24
20
INPUT 23
22

21 ET CLEAR e
QM—)

Number Function Description
1 POWER ON Turns on your interactive flat panel
STANDBY Turns off your interactive flat panel

2 Input buttons Selects input signal for the interactive flat panel

3 PICTURE MODE Selects picture mode

4 ASPECT Selects picture aspect

5 SOUND Selects artificial surround sound

6 Number pad Press buttons on the number pad to set and change
passwords, change channels or to customize or change
settings

7 ENT Enter

8 DISPLAY Turns on and turns off the on-screen display menu
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Number Function Description

9 MENU Turns on and turns off the menu mode

10 AUTO SET UP Enters auto setup menu

11 EXIT Returns to previous menu

12 Up/Down Moves the highlighted area up or down to select items within

the on-screen display menu
13 +/- Increases or decreases the adjustment level within the
on.screen display menu

14 SET Makes selection

15 VOL +/- Increases or decreases audio output level

16 CH +/- Changes the channel for the interactive flat panel

17 GUIDE Not in use

18 MUTE Mutes audio inputs for your interactive flat panel

19 STILL ON/OFF Turns on and off the still picture mode
CAPTURE Captures a stillimage

20 PIP ON/OFF Toggles between PIP, POP, side-by-side and side-by-side
PIP INPUT Selects the "picture-in-picture” input signal
PIP CHANGE Replaces to the main picture and sub-picture.

21 REMOTE ID Activates Remote ID function

22 MTS Not in use

23 Audio input Selects audio input source

24 Closed caption Activates closed captioning

34
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Using your SMART Board interactive flat panel, you can write, draw and erase digital ink, manipulate
objects and browse content on the screen.

About SMART Ink
SMART Ink enables you to write and draw in digital ink over open applications, files, folders,
websites and any other open window on your computer.

You can write over an Internet browser window, highlight content on your screen and write over a
video without pausing the video and without interfering with your ability to interact with the video.
When you move, resize or minimize a window, the ink stays with the window.

You can convert your digital ink notes to text. You can also move, erase and capture your notes as an
image and save it to your SMART software.

When you open an application that has its own ink tools, you can turn off SMART Ink, and then use
the application's ink tools to write.

For more information see SMART Ink for Windows (smarttech.com/Supportink1Windows) or
SMART Ink for Mac (smarttech.com/Supportink1Mac) on the SMART Support website.

SMART Ink Notes

SMART Ink Notes enable you to write in digital ink anywhere on your desktop. When you write
outside of the open windows on your computer, a SMART Ink Note appears and you can write inside
the note.

SMART Ink Document Viewer
If you're using a Windows operating system, the SMART Ink Document Viewer enables you to view
your PDF files and to write in digital ink over your files.

SMART Ink Toolbar

If your computer is connected to a SMART interactive product, SMART Ink starts automatically
when you start your computer and the SMART Ink toolbar appears in the title bar of each open
window on your computer.

Use the toolbar to select ink properties for that window and to perform common tasks such as
capturing your notes.
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About your SMART software
SMART Ink and SMART Product Drivers are included with SMART Notebook collaborative learning
software and SMART Meeting Pro software.

SMART Product Drivers
SMART Product Drivers enables your computer to detect input from your interactive flat panel.

SMART Ink works with SMART Product Drivers to enable you to write on your screen in digital ink
using your interactive flat panel’s pen or your finger.

NOTE

In most cases, SMART Product Drivers installs automatically when you install your SMART
software. To ensure you have the most recent version of SMART Product Drivers installed, see
Updating SMART Product Drivers on page 55.

SMART Notebook software

You can write in SMART Notebook software using your SMART interactive product’s pen or your
finger. The ink becomes part of your .notebook file. For more information, see the SMART Notebook
software support page for Windows (smarttech.com/SupportNotebook11Windows) or

SMART Notebook software support page for Mac OS X operating system software
(smarttech.com/SupportNotebook 11Mac).

SMART Meeting Pro software

You can write in SMART Meeting Pro software’s Whiteboard mode using your SMART interactive
product’s pen or your finger. The ink becomes part of your .notebook file. For more information, see
the SMART Meeting Pro support page (smarttech.com/SupportMeetingPro3Windows).

Writing or drawing in digital ink
Using the pen supplied with your interactive flat panel, you can write or draw digital ink over SMART
software and other programs.

To write or draw digital ink
1. Pick up the pen.

2. Write or draw on the screen.

£ nip

Don’t rest your elbow or the palm of your hand on the screen while you're writing.
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Entering text on the interactive flat panel
You can enter text in text boxes on the interactive flat panel using the on-screen keyboard or a
keyboard attached to your computer.

To enter text

1. Select the area where you want to enter text using your finger or a mouse connected to the
compulter.

2. Type on a connected keyboard or on-screen keyboard.

£ mip

Press the keyboard button on the interactive flat panel to open the on-screen keyboard.

Changing pen settings

You can change your pen settings, including line size and fill effects.

To change pen settings

1. Press the SMART Board icon | “]in the notification area (Windows operating systems) or the
Dock (Mac OS X operating system software).

OR
Press the SMART Meeting Pro icon H in the notification area.
2. Press SMART Settings.

3. Select Pen and Button Settings in the drop-down list.

4. Press Black Pen Settings to customize the black pen.

Press Blue Pen Settings to customize the blue pen.

R i

Press Red Pen Settings to customize the red pen.

Press Green Pen Settings to customize the green pen.

The Properties dialog box appears.
Press Line Style.
Adjust the color, thickness, line end and line style.

Press Fill Effects.

©® N o o

Adjust the transparency.
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9. Press Save Tool Settings to save your settings.
10. Optionally, repeat steps 4 through 9 to customize other pens.

11. Press OK to close SMART Settings.

Using Locked Ink mode

Locked Ink mode enables you to write or draw digital ink using large objects, including eraser-sized
objects.

To use Locked Ink mode

Press and hold a color button on the color select module until the light flashes.

To end Locked Ink mode

Press any color button that isn't flashing on your color select module.
Erasing digital ink

To erase digital ink

Pick up the eraser, and then press the eraser on the screen and move it over the digital ink you
want to erase.

OR

Using your flattened fist, press the screen and move your hand over the digital ink you want to
erase.

T -
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Changing eraser settings
You can change the eraser size for either a larger or smaller eraser area.

To change eraser settings

1.

w

N o o A

Press the SMART Board icon [“in the notification area (Windows operating systems) or the
Dock (Mac OS operating system software), and then select SMART Settings.

OR
Press the SMART Meeting Pro icon FH in the notification area, and then select
SMART Settings.

Press SMART Hardware Settings.

Select Pen and Button Settings in the drop-down list.

Press Eraser Settings E

Select an eraser size.
Press OK to save your settings.

Press OK to close SMART Settings.

Manipulating objects
Objects include icons, buttons, links and other components of programs that appear on your screen.
You can manipulate these objects on your interactive flat panel as described below.

To select or clear the selection of an object

39

Quickly press and release the object.
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NOTES
o This gesture performs a standard mouse click.

o This gesture starts programs if your operating system is set to start applications on a
single click.

To double-click an object

Quickly press and release the object twice in the same spot.

——

P

NOTE

This gesture starts programs if your operating system is set to start applications on a double-
click.

To right-click or Control-click an object

Press and hold the object.

T

/

OR
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Using two fingers on the same hand, press and hold the object with your left finger, and then
press the screen once with your right finger.

[

1 2

=

OR

Press the Right-Click button on the pen tray, and then press the object.

To move an object
1. Press and hold the object.
2. Keeping your finger on the screen, slowly move the object.

3. When you reach the position you want to move the object to, release your finger.
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. To resize an object
1. Using one finger on each hand, press the screen at opposite ends of the object.

2. Drag your fingers in opposite directions to enlarge the object.

OR

Drag your fingers toward each other to reduce the object.

]
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To rotate an object
1. Using one finger on each hand, press the screen at opposite ends of the object.

2. Rotate your fingers in the direction you want to rotate the object.

3. When you reach the angle you want to rotate the object to, release your fingers.

Browsing
In addition to manipulating objects, you can browse content on your screen.

To display the next page

Press the screen, and then quickly press again directly to the right of that point.

OR
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Quickly flick your finger right across the screen.

k@

To display the previous page

Press the screen, and then quickly press again directly to the left of that point.

\

o

OR

Quickly flick your finger left across the screen.

N
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. To zoom in or out

1. Using one finger on each hand, press the screen at opposite ends of the object.

2. Drag your fingers in opposite directions to zoom in.

OR

Drag your fingers toward each other to zoom out.
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To pan horizontally or vertically

1.

Using two fingers on the same hand, press and hold the screen.

2. Keeping your fingers on the screen, move up, down, left or right.

3. When you reach the area you want to view, release your fingers.

Your interactive flat panel includes two speakers that play audio files or the audio portion of a video

file.

When you play an audio file or a video file on a computer connected to your interactive flat panel, the
file is streamed through the USB connection between your computer and your interactive flat panel,
not through the video connection.

IMPORTANT

If your computer uses Mac OS X operating system software, you must set the audio output to
USB.

To switch your Mac computer to USB audio output

1.

2
3
4.
5

46

Press the Apple menu I', and then select System Preferences.
Press Sound under the Hardware section.

Press the Output tab.

Select SBID 8070i/USB.

Close System Preferences.
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You can connect a USB drive or device to the USB receptacle on the side terminal panel on your
interactive flat panel, and then access it from the room computer connected to VGA and USB 1.

NOTE

To disable the USB A receptacle on the side terminal panel, see Disabling the USB receptacle on
the side terminal panel on page 22.

Menu control panel ‘[:
MENY . \
USB receptacle — [ L i
for a USB drive \@%79 o
USB B receptacle for . #
guest laptop NG 2
(USB 3) M :
HDI video input -
for guest laptop \

(HDMI 2) ~__

To use the USB receptacle

1. Press the VGA button on the remote control.

You can also press the Input button B] on the front control panel until it is set to VGA.
2. Connect a USB device to the USB receptacle.

3. Use the room computer to access the content on your USB device.
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About the SMART Meeting Pro application

The appliance that comes with your SMART Board 8070ie-SMP interactive flat panel is installed with
software, including the SMART Meeting Pro application. The SMART Meeting Pro application
enables you to work with various types of digital content, from application files and documents to
images and websites. You can display files on your interactive flat panel and write notes in digital ink
during collaborative work sessions. You can mark up PDF or presentation files, write notes over web
pages or simply make whiteboard notes, and then capture and save your work forimmediate
distribution.

You can also integrate the SMART Meeting Pro application with Microsoft Exchange and Bridgit®
conferencing software, enabling you to automate your conferencing and conduct effective meetings.

Getting started with the SMART Meeting Pro application

The SMART Meeting Pro application starts automatically when you start your interactive flat panel.

See the Help for more detailed information on how to use SMART Meeting Pro application.
To access the SMART Meeting Pro application Help

1. Press the Whiteboard -“ button.

2. Press Help from the menu, and then select Contents.
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You can connect a second laptop to the installed USB cable and video cable that is connected to the
back terminal panel of your interactive flat panel. If those cables aren't installed, connect the laptop to
the side terminal panel (see Connecting a side laptop on page 51). For a diagram of the various
computer options, see Connecting computers to your interactive flat panel on page 18.

IMPORTANT

The laptop must have SMART Product Drivers installed. If it doesn’t, you need to connect the
laptop to the interactive flat panel using a SMART GoWire cable. If you purchased an
SBID8070i-SMP or SBID8070ie-SMP model, you can use the supplied SMART GoWire cable to
connect your laptop to the interactive flat panel. For more information, see Usinga SMART GoWire
cable on the next page.

To connect a laptop

—_

Place the laptop beside the end of the wire bundle at the guest laptop connection.
Connect the installed USB cable to a USB receptacle on the laptop.
Connect the VGA cable connector to the laptop.

Turn on the laptop.

o > 0 DN

Press the RGB/HV button on the remote control.

OR

Press the Input button =] on the front control panel until the input source is RGB/HV.
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To return to using the room computer
Press the VGA button on the remote control.

OR

Press the Input button ] on the front control panel until the input source is VGA.

Any computer connected to your interactive flat panel requires SMART software. Typically, you
install this software on your room computer so that it's always ready to use.

However, if you want to connect a laptop that doesn’'t have SMART software installed, you can
connect a SMART GoWire cable from the laptop to the USB cable for your interactive flat panel. The
SMART GoWire cable enables you to have touch control of your laptop and use SMART Meeting Pro
software without installing the software on your laptop.

SMART Board 8070i-SMP interactive flat panels include a SMART GoWire cable. Additional
SMART GoWire cables can be purchased from your authorized SMART reseller
(smarttech.com/where).

IMPORTANT

Your interactive flat panel supports the SMART GoWire cable with SMART Meeting Pro software
only. It does not support the SMART GoWire cable with SMART Notebook software.

To use a SMART GoWire cable
1. Connect a video cable from your interactive flat panel to your laptop.
2. Connect the USB cable from the USB receptacle on your interactive flat panel to your laptop.

3. Change the video input to your laptop's video connection using the remote control or the front
control panel.

4. Disconnect the USB cable from your laptop, and then connect it to the SMART GoWire cable’s
USB A receptacle.
IMPORTANT

If the SMART GoWire cable is not connected to your interactive flat panel through a USB
cable, you have access to SMART Meeting Pro software on your laptop for five minutes, and
then the software closes.
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5. Connect the SMART GoWire cable’s USB connector to your laptop.
The AutoPlay dialog box appears.
6. Select Start SMART Meeting Pro.

SMART Meeting Pro software starts. You have touch control of your laptop on your interactive
flat panel and can use SMART Meeting Pro software while your laptop is connected to your
interactive flat panel.

To disconnect a SMART GoWire cable

1. Save your SMART Meeting Pro software file to your laptop, if required. You can save the file as
a .ppt, .pdf or .notebook file.

IMPORTANT

You can open a .notebook file on a computer that has SMART Meeting Pro software or
SMART Notebook software installed or that is connected to a SMART product through a
SMART GoWire cable only.

2. Press the SMART Meeting Pro icon in the notification area, and then select Exit.

3. Disconnect the SMART GoWire cable from your laptop and the USB cable for your interactive
flat panel.

You can connect a side laptop to the side terminal panel of the interactive flat panel. When a side
laptop is connected, the laptop’s desktop is displayed on the interactive flat panel and touch
interactivity is enabled. For a diagram of the various computer options, see Connecting computers to
your interactive flat panel on page 18.
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To connect a side laptop

1.

Connect an HDMI cable from the side laptop’s HDMI input to your interactive flat panel’s side
terminal panel.

Connect a USB cable from the laptop's USB receptacle to your interactive flat panel’s side
terminal panel.

IMPORTANT

The USB A receptacle is for USB devices only. Do not connect the side laptop to this
receptacle.

Turn on the laptop.
Press the HDMI input button on the remote control twice.

OR

Press the Input button ] on the front control panel until the input source is HDMI 2.

To return to using the room computer

1.

2.

52

Press the VGA button on the remote control.

OR

Disconnect the side laptop from the interactive flat panel if required.
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If you properly maintain your interactive flat panel, it will provide years of use.

To use touch control and digital ink on your interactive flat panel, you require SMART software on
your computer and up-to-date firmware on your interactive flat panel.

Updating SMART software

Once you have SMART software installed on your computer, you can check for software updates
with SMART Product Update by selecting Help > Check for Updates in the software or by browsing
to smarttech.com/downloads.
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To check for software updates

1.
2.

3.

Start your SMART software program.
Click Help > Check for Updates.

IMPORTANT

If you do not see the Check for Updates option, contact your network administrator.

Click the Update button beside the software you want to update.

SMART software updates.

IMPORTANT

When you update SMART software on your computer, a firmware update for your interactive flat
panel could download to your computer. The next time you connect your computer to your
interactive flat panel you are informed that there is a firmware update for the processor in the
interactive flat panel. For more information, see Updating your interactive flat panel firmware
below.

Updating your interactive flat panel firmware

Al

CAUTION

Only a system administrator should update interactive flat panel firmware.

Your interactive flat panel uses firmware on its processor. After you update SMART software, a new
firmware executable file could save on your computer. When you connect a computer with this file to
your interactive flat panel, your interactive flat panel detects this executable file, and then prompts
you to run the file to update the firmware.

Al
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CAUTION

Do not disconnect your interactive flat panel from your computer during the firmware update
process.

Do not touch your interactive flat panel’s screen or input button during the firmware update
process.

Do not turn off your computer or your interactive flat panel during the firmware update process.
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To update your interactive flat panel firmware
1. Ensure your interactive flat panel is connected to your computer.
2. Launch the firmware updater at the following location:

Windows computers: C:\Program Files\SMART Technologies\SMART Product
Drivers\SMARTFirmwareUpdater.exe.

Mac computers: HD\Applications\SMART Product Drivers\SMARTFirmwareU pdater.app.

3. Follow the on-screen instructions using your computer's mouse and keyboard. Don’t touch the
interactive flat panel screen.

4. Select the check box for the SMART interactive product you want to update, and then click
Next.

A progress bar appears.

NOTE
SC14 refers to the SMART Board 8000 series interactive flat panel’s serial controller.

5. When the installation is complete, calibrate your interactive flat panel. See Calibrating your
interactive flat panel on the next page

Updating SMART Product Drivers
To use touch control and digital ink on your interactive flat panel, you require SMART Product Drivers
11 or later on your computer.

To update SMART Product Drivers

1. Click the SMART Board icon [ “]in the notification area (Windows operating systems) or the
Dock (Mac OS X operating system software), and then select Check for Updates and
Activation.

OR

Click the SMART Meeting Pro icon [ in the notification area and then select Check for
Updates and Activation.

The SMART Product Update window appears.
2. If yourversion of SMART Product Drivers is up-to-date, click OK.
If your version of SMART Product Drivers needs to be updated, click Update.

3. Follow the on-screen instructions to update SMART Product Drivers to the latest version.
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Digital cameras in the corners of the interactive flat panel track the position of the pens, eraser and
your finger on the interactive surface, and then send the information to the SMART software, which
interprets this information as mouse clicks, digital ink or ink removal in the appropriate location.
Calibration determines the position and angles of the cameras to accurately identify the location of
touches on your interactive flat panel.

IMPORTANT

If an error message appears while you are calibrating your interactive flat panel, contact SMART

Support (smarttech.com/contactsupport).

To calibrate your interactive flat panel

1.

o o &> w
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Press the SMART Board icon |.“ 1 in the notification area (Windows operating systems) or the
Dock (Mac OS X operating system software).

OR

Press the SMART Meeting Pro icon ] in the notification area.

Select SMART Settings.

SMART Settings appears.

Press SMART Hardware Settings.

If you have more than one SMART product connected, select the interactive flat panel.
Select Advanced Settings from the drop-down list.

Press Calibrate.

The calibration screen appears. This can take a few moments.

Press the red target with the tip of an interactive flat panel pen. Hold the tip at the center of the
target until the target turns green, and then lift the pen.

The target moves to the next location.

NOTE

You can calibrate a target again by pressing the LEFT ARROW key on your keyboard, or the
Keyboard button or Right-click button on the color select module.

Continue pressing targets until the calibration is complete.

A message appears stating that the calibration was successful, and then the orientation screen
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appears.

Orient your interactive flat panel.

When the location of your touch is misinterpreted (a pointer appears a distance from the actual
contact), orient your interactive flat panel.

To orient the interactive flat panel

1. Press the orientation button ‘=‘ on the color select module.
The orientation window opens.

2. Use aninteractive flat panel pen to press the red targets as they appear. Hold the tip of the pen
at the center of each target, and then lift the pen. When you lift the pen, the target moves to the

next orientation point.

IMPORTANT

Hold the pen perpendicular to the screen.
3. Continue until you've pressed all the targets.
The orientation window closes.

If this doesn’t correct inaccurate touch control, calibrate your interactive flat panel. For more
information, see Calibrating your interactive flat panel on the previous page.

To prevent damage to your interactive flat panel’s anti-glare coating, replace your pen nib if it
becomes worn. Eight replacement pen nibs are included with your pens, and you can purchase
additional replacements from your authorized SMART reseller (smarttech.com/where).

To replace a pen nib

1. Grasp the worn nib on your pen with a pair of pliers, and then pull and twist the nib loose.

2. Press the replacement nib into the pen.
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Follow these instructions to clean the interactive flat panel screen without damaging its anti-reflective
coating or other product components.

CAUTION

o Do not use permanent or dry-erase markers on the screen. If dry-erase markers are used on
the screen, remove the ink as soon as possible with a lint-free, non-abrasive cloth.

o Do not rub the screen with a dense or rough material.
o Do not apply pressure to the screen.

« Do not use cleaning solution or glass cleaner on the interactive flat panel screen, as they can
deteriorate or discolor the screen.

o Avoid touching the silver reflective tape between the screen and the bezel and ensure that it
stays dry. Damage to this strip affects touch interactivity.

To clean the interactive flat panel screen

1. Shut off your computer, and then disconnect the power sources for your computer and your
interactive flat panel.

2. Wipe the screen with a lint-free, non-abrasive cloth.

The DVIT technology in your interactive flat panel uses four cameras in the corners of the frame and
the reflective material between the screen and the bezels. Excessive dust buildup on the camera
windows or reflective tape can impair touch performance.

These areas should be inspected annually for dust and should be cleaned if any obvious dust buildup
has occurred.

CAUTION
e Do not use compressed air to clean the camera windows or borders.

o Do not use water, chemicals or cleaning agents.
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To clean the camera windows and reflective tape
1. Gently wipe the reflective tape along the sides of your interactive flat panel screen.

2. Gently wipe the camera windows in the bottom corners and the reflective strip across the bottom
of your interactive flat panel screen.

Your interactive flat panel requires ventilation to enable the cooling fans to function. Dust buildup in
the ventilation holes compromises cooling and leads to product failure.

'S cAuTION

Avoid setting up or using your interactive flat panel in an area with excessive levels of dust,
humidity or smoke.

o Clean accessible ventilation holes monthly with a dry cloth.

¢ Use avacuum cleaner with a narrow hose end fitting to clear the back ventilation holes annually.
You might have to remove the interactive flat panel from your wall. For more information on
removing your interactive flat panel see Removing your interactive flat panel on the next page.

Your interactive flat panel screen contains layers of glass that can collect condensation, especially in
the following conditions:

e Temperature extremes with high humidity

o Rapid changes in humidity, which can occur when you operate the product near water, such as a
sink, pool, kettle or air conditioner ventilator

o Direct exposure to sunlight

To evaporate condensation from your interactive flat panel
1. Remove the humidity source from the interactive flat panel, if possible.
2. Adjust the room temperature to normal operating ranges.
3. Tum on the interactive flat panel for 2-3 hours.

If the screen condensation doesn’t evaporate, contact SMART Support
(smarttech.com/contactsupport).
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Inspect your interactive flat panel installation frequently to ensure that it remains securely installed.
¢ Check the mounting location for signs of damage or weakness that can occur over time.
e Check for loose screws, gaps, distortions or other issues that could occur with the mounting

apparatus.

If you find an issue, refer to a professional installer.

To safely remove your interactive flat panel, use four or more professional installers.

Y WARNING

o Do not attempt to move the interactive flat panel using your own strength. The interactive flat
panel is very heavy.

« Do not move the interactive flat panel by connecting a rope or wire to the handles on the back.
The interactive flat panel can fall and cause personal injury and product damage.

IMPORTANT

Follow the instructions included with the floor stand or mounting apparatus.

To remove the interactive flat panel
1. Turn off your interactive flat panel and unplug the power cable from the wall outlet.
2. Remove all accessible cables and connectors.

3. Attach the M12 eyebolts for your lifting equipment. For more information, see Wall-mounting
your interactive flat panel on page 12.

4. Lift your interactive flat panel from its mounting location.

Y cAuTION

o Do not leave the interactive flat panel face up, face down or upside down for an extended
period of time as it could cause permanent damage to the screen.

o Do not place the interactive flat panel on a sloping or unstable cart, stand or table,
because the interactive flat panel could fall, resulting in injury or severe product damage.
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'Y CAUTION

o Do not leave the interactive flat panel face up, face down or upside down for an extended
period of time as it could cause permanent damage to the screen.

o Do not place the interactive flat panel on a sloping or unstable cart, stand or table,
because the interactive flat panel could fall, resulting in injury or severe product damage.

Save your original packaging so that you can repack your interactive flat panel with as much of the
original packaging as possible. This packaging was designed with optimal shock and vibration
protection. If your original packaging isn’t available, you can purchase the same packaging directly
from your authorized SMART reseller (smarttech.com/where).

'S cAuTION

Transport your interactive flat panel only in original or replaced packaging. Transporting your
interactive flat panel without correct packaging voids your warranty and could lead to product
damage.
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This chapter provides you with the information necessary to solve simple issues that can occur with
your interactive flat panel. If issues persist, or aren’t covered in this chapter, contact SMART Support
(smarttech.com/contactsupport).

Complete the following steps if your interactive flat panel doesn’t display an image correctly or
doesn’t display any image at all.

Diagnosing blank screen issues using the front control panel lights
Use the following troubleshooting table when your computer is turned on, but you don’'t see an image
on the interactive flat panel screen.

Begin by looking at the interactive flat panel system status light and the power light in the front control
panel.
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Power Status Causes Solutions
light light
Off Off The interactive flat panel isn’t Connect your interactive flat panel’s
connected to a power source. power cable to a power outlet (see page
19).
The main power switch is off. Turn on the main power switch on the
terminal panel (see page 7).
Solid Off The interactive flat panel is Press the power button on the front control
red turned off. panel or the remote control.
Solid Red The computer is off. Turn on your computer.
amber or
red
The computerisn’t connectedto  Connect your computer to your interactive
your interactive flat panel. flat panel with the required cable (see
page 18).
The interactive flat panel isn’'t set  Select your computer’s input source
to the correct video input source.  (typically VGA, RGB/HV or HDMI 2)
using the remote control.
OR
Press the Power button (U until the Input
button B ] is blue, and then press the
Input source button until your computer's
desktop appears.
Solid Flashing The interactive flat panel is Do not touch the interactive flat panel. For
green amber updating firmware. more information, see page 53.

Solid Flashing The interactive flat panel detects Install SMART software on your computer
green green a computer, but (see page 25) or install a SMART GoWire
SMART Product Drivers isn’t cable (see page 50).

installed or isn’'t running. (For

more information, see page 68).
Solid Solid The interactive flat panel detects Normal operation.
green green a computer with

SMART Product Drivers

installed.
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Resolving poor image quality

Symptom Causes

Solution

Theimageistoo  The computer’s video
large, too small or resolution settings don’t
doesn’t match your interactive flat

completely fill the panel’s native resolution.
screen.

The interactive flat panel’s native resolution is
1920 x 1080 at 60 Hz.

If your computer can’t support this resolution,
consider one of the following 16:9 resolutions as
an alternative:

e 1600 x 900
o 1366 x 768
e 1280 x 720

Other resolutions could result in image distortion
or black bars around the desktop.
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Solution

Symptom Causes

The screen The computer’s video card
resolution is is underscanning the
correct, but the image.

image is

surrounded by

black bars.

Turn off or adjust the overscan/underscan feature
in the video card driver software until the image
fits the screen resolution. Refer to your
computer’s video card help for more information.

NOTE

If available, select the HDTV setting (ideally
1080p) from your video card driver's advanced
menu. This should provide a pixel-perfect image
for your interactive flat panel.

You have a poor quality
video cable.

1. Replace your video cable with a better quality
video cable.

2. Pressthe AUTO SET UP button on your
remote control to reset your interactive flat
panel.

OR

Select MENU > ADJUST > AUTOSET on
the menu control panel. (For more
information, see page 75.)

You connected two video
cables together.

1. Replace your two cables with one longer

cable.

OR

Move your computer so that it’s within a
single cable length of your interactive flat
panel.

2. Press the AUTO SET UP button on your
remote to reset your interactive flat panel.
OR
Select MENU > ADJUST > AUTO SETUP
on the menu control panel. (For more
information, see page 75.)

The image isn’t
centered on the
screen.

Press the AUTO SET UP button on the remote
control.

OR

Select MENU > ADJUST > AUTO SET on the
menu control panel. (For more information, see
page 75.)
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Symptom Causes Solution

The image is The video connection is Secure the video cable to both your computer and
unstable or loose. your interactive flat panel.

unfocused.

You have a poor quality
video cable

1. Replace your video cable with a better quality
video cable.

2. Pressthe AUTO SET UP button on the
remote control to reset your interactive flat
panel.

OR

Select MENU > ADJUST > AUTO SETUP
on the menu control panel. (For more
information, see page 75.)

You connected two video
cables together.

1. Replace your two cables with one longer
cable.

OR

Move your computer so that it's withina
single cable length of your interactive flat
panel.

2. Press the AUTO SET UP button on your
remote to reset your interactive flat panel.
OR
Select MENU > ADJUST > AUTO SETUP

on the menu control panel. (For more
information, see page 75.)

Your computer’s video
display card is defective.

Connect a different computer to your interactive
flat panel. If this improves the image quality,
consider replacing the video card in the original
compulter.

The image is too
light, too dark or
has poorimage
quality issues.

You might have incorrect
video settings.

Access the on-screen display menu to adjust
picture settings, or select MENU > ADVANCED
OPTION > FACTORY RESET > YES on the
menu control panel. (For more information, see
page 75.)

Thereis a
persistent image
on the screen.

An image was displayed for
too long.

Turn off your interactive flat panel and leave it
turned off for as long as the image was on the
screen.

] 1P

Use a screen saver to avoid persistent images.

Other display
quality issues

Select MENU > ADVANCED OPTION >
FACTORY PRESET > YES on the menu control
panel. (For more information, see page 75.)
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Use the following troubleshooting table if you can see your computer desktop on your interactive flat
panel, but you do not have touch control over the desktop.

For more information, see SMART Ink user’s guide for Mac OS X operating system software
(smarttech.com/kb/170192) or SMART Ink user’s guide for Windows operating system

(smarttech.com/kb/170191).

Symptom Causes Solution
When you touch the screen, no  The Update your SMART Product Drivers
pointer appears and you can’t SMART Product Drivers (see Updating SMART Product Drivers

move icons. The status light is
red.

on your computer are
not current.

on page 55).

No USB connection
from the computer to the
interactive flat panel.

Verify your connections (see page 18).

Your USB connection
doesn’t correspond with
the selected video input.

Connect the USB to the correct
receptacle that corresponds to your
computer’s video input. (For more
information, see page 18.)

The SMART Meeting Pro icon
EH or the SMART Notebook

icon |- /| doesn't appear.

SMART Product Drivers
isn’t installed.

Download and install SMART software
from smarttech.com/downloads.

OR

Connect your computer or laptop to your
interactive flat panel with a

SMART GoWire cable. (For more
information, see page 50.)

SMART software isn’t
running.

Open the SMART Product Drivers
folder in your list of programs, and then
select SMART Board Tools.

The SMART Board icon | “1or
SMART Meeting Pro icon Elis

crossed out in red.

Your computer can’t find
your interactive flat
panel.

Start SMART software, and then run
the SMART Connection Wizard’s
troubleshooting procedures.

Either the SMART
Board Diagnostics
window or SMART
Settings is open.

Close the SMART Board Diagnostics
window and the SMART Settings
panel.
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Symptom

Causes

Solution

Touch interactivity is slow or
sluggish.

Your computer is
running too many
applications.

Close some open applications.

Your computer doesn’t
meet system
requirements.

Upgrade your computer or replace it
with a more powerful computer.

You haven't used a USB
2.0 cable to connect
your interactive flat
panel to your computer.

Use aUSB 2.0 cable and ensure it is
connected to a USB 2.0 receptacle on
your computer.

When you touch the screen the
pointer appears in the wrong
location.

You aren’t touching the
screen at right angles.

For more information, see Touching and
drawing on your SMART Board
interactive whiteboard is Inaccurate
(smarttech.com/kb/131299).

Your interactive flat
panel isn’t oriented.

Orient your interactive flat panel. Press
the orient button -} on the color select
module, and then follow the on-screen
instructions. (For more information, see
page 57.)

Your desktop isn’t
centered on the screen.

Press the AUTO SET UP button on
your remote control to reset your
interactive flat panel.

OR

Select MENU > ADJUST > AUTO
SETUP on the menu control panel. (For
more information, see page 75.)

IMPORTANT

You might have to do this more than
once.

An area of the screen doesn’t
respond to your touch or when
you draw digital ink, the lines
are broken.

Something is blocking
the cameras.

Ensure nothing is taped to the screen.

Something is on the
reflective tape channel.

Remove items from the reflective tape
channel.
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Symptom

Causes

Solution

Your finger or pen is
skipping as you draw.
This is most common on
the upstroke.

Use consistent pressure while drawing
digital ink.

Bright lights are
interfering with the
cameras.

Close blinds or shades or dim all
halogen lights and LEDs.

Your cameras require
calibration, possibly due
to temperature change
in the room.

Calibrate your interactive flat panel.
(See page 56.)

You try to erase using

something other than the eraser,
but you draw more digital ink.
One of the color select button

lights is flashing.

You're in Locked Ink
mode and all objects are
interpreted as pens.

Press a color select button that isn’t
flashing to exit Locked Ink mode.

OR

Remove the eraser from the eraser
holder to enable erasing while in Locked
Ink mode.

You try to erase with the eraser,
but you draw more digital ink.
You don'’t see a flashing light on

the color select module.

You're using an edge of
the eraser.

Increase the contact area of your
eraser.

You're trying to draw digital ink,

but you see a circle beneath

your pointer and you're erasing

digital ink.

Your interactive flat
panel is interpreting an
eraser.

Lift other fingers and the heel of your
hand from the interactive flat panel
while you write because the interactive
flat panel is interpreting them as an
eraser.

OR
Use a smaller pointer, such as the pen.
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IMPORTANT

Ensure you can see your computer’s desktop and have touch control and digital ink before using
this table. If not, resolve those issues before completing the following steps in the table below.

Symptom

Causes

Solution

Sound doesn’t play
when you play a
sound file.

Your computer is muted.

Turn off the mute setting.

Your computer's volume is too low.

Turn up the volume on your
compulter.

Your interactive flat panel is muted.

Turn off the mute setting using the
remote control or the front control
panel.

Your interactive flat panel’s volume is too

low.

Use the remote control to turn up
the volume on your interactive flat
panel.

OR

Use the volume control on the
front control panel.

The wrong audio input is selected for the

video input.

Select the correct audio input.
Press AUDIO INPUT on the
remote control.

Your computer uses Mac OS X operating
system software and is not set to Audio

USB output.

Set your computer’s audio output
to USB. (For more information,
see page 46.)
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Y our remote control provides control of your interactive flat panel up to 23' (7 m) from the front control
panel of your interactive flat panel.

Symptom Causes

Solution

The remote control Your interactive flat panel isn’t
behaves unexpectedly. receiving power.

The front control panel

power button light is

Ensure your interactive flat panel is
plugged in and that the power switch on
the bottom terminal panel is in the ON
position. (For more information, see page

off. 7.)
You are outside the range of the Move to within 23' (7 m) and a 30° arc of
infrared remote control sensor.  your infrared remote control sensor.
The remote control batteries Replace the batteries. (For more
needs to be replaced. information, see page 31.)
The remote control is damaged. Contact your authorized SMART reseller
(smarttech.com/where) to inquire about
a replacement remote control.
Something is plugged intothe  Unplug the connector from the wired
wired remote control remote control receptacles. (For more
receptacles on the audio information, see page 16.)
connection panel, disabling the
remote control.
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You can resolve a variety of issues using the SMART Connection Wizard found in SMART Settings.

To start the SMART Connection Wizard

1.

Press the Help button on the color select module.
The Help and Support for Your SMART Board Interactive Whiteboard window opens.
Press Connection Wizard.

The SMART Connection Wizard opens.

NOTE

You can also access the SMART Connection Wizard by pressing the SMART Board icon |
in the notification area (Windows operating systems) or the Dock (Mac OS X operating system
software), and then selecting SMART Settings > Connection Wizard.

OR

Click the SMART Meeting Pro icon [ in the notification area, then select SMART Settings
> Connection Wizard.

3. Select SMART Board 8000 series interactive flat panel, and then press Next.

4. Select the option that best describes the issue you're encountering, and follow the on-screen
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instructions to troubleshoot your interactive flat panel.
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CHAPTER 8

Troubleshooting for your interactive flat panel

If you touch the interactive flat panel’s surface and nothing happens, or if there is no digital ink or the
ink appears in some locations and not in others, use SMART Board Diagnostics to help identify and

resolve these issues.

IMPORTANT

Do not change diagnostic settings unless asked to do so by SMART Support.

Checking the camera view
If nothing happens when you touch the interactive flat panel’s surface, check to make sure that
nothing is blocking one of the cameras.

To check camera views

1.
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Press the SMART Board icon | “1 in the notification area (Windows operating systems) or the
Dock (Mac OS X operating system software).

OR

Press the SMART Meeting Pro icon [ in the notification area.

Press SMART Settings.

SMART Settings opens.

Select About Software and Product Support > Tools > Diagnostics.
SMART Board Diagnostics opens.

In the View menu, select SBX800/SBID8070i/SBID8055i Bar.

The SBX800 group box appears in the SMART Board Diagnostics screen.
Press View.

The camera view screen appears.

Click Update to display the four camera views. This could take a few moments.

If one of the camera views remains black, the camera is blocked or can’t locate the reflective
tape on the interactive flat panel’s inner frame.

Check the camera lens and ensure that nothing is blocking its view and that nothing is affixed to
the interactive surface.
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Adjusting video settings with the
on-screen display menu

Changing settings inthe OSD mMenuU . ... e 75
Main menu Settings ...l 76
Picture Settings .. ... il 76
Adjustment settings ...l 77
AUdIo SEHINGS .. L 77
Schedule settings ... 78
PIP (Picture in Picture) settings .. ... .. 78
OSD SettiNGS ... 79
Multi-display SetiNgs ... . L 79
Display protection settings ... .. 80
Advanced option SettiNgs ... ... o 82

You can access the on-screen display (OSD) menu using either the remote control (see Infrared
remote control buttons on page 33) or the menu control panel on the left side of the interactive flat
panel (see Left side view on page 6).

NOTE

You can adjust many of the interactive flat panel screen settings using the remote control.

To change settings in the OSD menu
1. Press the MENU button on the menu control panel or the remote control.
The on-screen menu appears.
2. Press the left and right arrows to select a menu.

3. Press SET.
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4. Press the up and down arrows to select the setting you want to change.
5. Press SET.
6. Press the left arrow to decrease or the right arrow to increase the value.
OR
Press the up arrow or down arrow to select a value.
7. Press SET.
8. To change another setting in the menu, press the MENU button and then repeat steps 2—4.

9. When you finish changing settings, press the MENU button twice to close the on-screen display
menu.

Picture settings

Menu item Function
BRIGHTNESS Adjusts the overall brightness of the image and background.
NOTE
You can’t change this setting when picture mode is set to AMBIENT1
or AMBIENT2.
CONTRAST Adjusts the brightness of the image in relation to the background. The
sRGB picture mode is standard and cannot be changed.
SHARPNESS Adjusts the sharpness of the image.
BLACK LEVEL Adjusts the brightness of the image in relation to the background. The
sRGB picture mode is standard and cannot be changed.
TINT Adjusts the tint of the screen.
COLOR Adjusts the color depth of the screen.
COLOR Adjusts the color temperature of the entire screen. The sRGB picture
TEMPERATURE mode is standard and cannot be changed.
COLOR CONTROL Adjusts the levels of red, yellow, green, cyan, blue, magenta and
saturation. The sRGB picture mode is standard and cannot be
changed.

GAMMA SELECTION Selects a display gamma for best picture quality. The sRGB picture
mode is standard and cannot be changed.
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Menu item Function

MOVIE SETTING Sets NOISE REDUCTION, FILM MODE and ADAPTIVE
CONTRAST.

PICTURE MODE Sets picture mode to HIGHBRIGHT, STANDARD, sRGB, CINEMA,

AMBIENT1 or AMBIENT2.

PICTURE RESET Restores the picture settings to their default values.

Adjustment settings

Menu item Function

AUTO SETUP Adjusts Screen Size, H position, V position, Clock, Clock Phase and
White Level automatically.

AUTO ADJUST Sets H Position, V Position and Clock Phase to adjust automatically
when your interactive flat panel is turned on.

H POSITION Controls the horizontal position of the image within the screen area.

V POSITION Controls the vertical position of the image within the screen area.

CLOCK Adjusts the width of the image.

CLOCK PHASE Adjusts the visual noise on the image.

H RESOLUTION Adjusts the horizontal size of the image.

V RESOLUTION Adjusts the vertical size of the image.

INPUT RESOLUTION Displays the signal at the desired resolution. After selecting this, use
the AUTO SETUP option above.

Z0O0OM MODE Selects the aspect ratio of the screen image.

ASPECT Sets picture aspect to FULL, NORMAL, TRIM or ZOOM.
ADJUST RESET Restores the adjustment settings to their default values.
Audio settings

Menu item Function

BALANCE Adjust the balance of left and right volume.

TREBLE Adjusts the high frequency sound.
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Menu item Function

BASS Adjusts the low frequency sound.

PIP AUDIO Selects the sound source when in Picture in Picture mode.
LINE OUT Selects FIXED or VARIABLE audio line out.
SURROUND Sets artificial surround sound.

AUDIO INPUT Sets audio input source to IN1, IN2, IN3, HDMI or TV.
AUDIO RESET Restores the audio settings to their default values.

Schedule settings

Menu item

Function

OFF TIMER

Sets the time from the last input to when the interactive flat panel
automatically turns off. You can set this from 1-24 hours.

SCHEDULE SETTING

Creates a schedule for the interactive flat panel to use.
IMPORTANT

You must set the date and time values before you can set a
schedule.

SCHEDULE LIST Displays the interactive flat panel’s schedules.
DATE & TIME Sets the date, time, time zone and daylight savings time.
SCHEDULE RESET Restores the schedule settings to their default values.

PIP (Picture in Picture) settings

Menu item

Function

KEEP PIP MODE

Enables the interactive flat panel to remain in PIP and TEXT TICKER
modes after it's turned off and turned on again.

PIP MODE Sets the sub-picture mode to PIP, POP, SBS aspect or SBS full.
PIP SIZE Selects the size of the sub-picture used in PIP mode.

PIP POSITION Determines where the PIP appears on the screen.

ASPECT Selects sub-picture aspect. Options are FULL, NORMAL, WIDE and

ZOOM.
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Menu item Function

TEXT TICKER Allows text insertion in main screen with the ability to adjust.
SUB INPUT Selects sub-picture input signal.

PIP RESET Restores the PIP settings to their default values.

OSD settings

Menu item Function

LANGUAGE Selects the language used by the OSD menu.

OSD TURN OFF

Turns off the OSD menu after a period of inactivity. The preset choices
are 10-240 seconds.

OSD POSITION

Sets where the OSD menu appears on the screen to Left or Right.

INFORMATION OSD

Selects if the Information OSD menu is displayed.

MONITOR
INFORMATION

Displays interactive flat panel information.

CARBON SAVINGS

Displays the estimated carbon saving information in kilograms.

OSD TRANSPARENCY

Sets the transparency level of the OSD menu.

OSD ROTATION

Sets the OSD menu display direction to landscape or portrait.

INPUT NAME Sets INPUT name. Maximum length is 8 letters, and you can use
spaces, letters from A-Z, numerals from 0-9 and some symbols.

CLOSED CAPTION Activates closed captioning.

OSD RESET Restores the OSD settings to their default values.

Multi-display settings

Menu item Function
MONITOR ID Sets the monitor ID number from 1 to 100 and the group ID from A to J.
IR CONTROL Selects the mode of the interactive flat panel for use with the remote

control when using the RS-232C daisy chain.
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Menu item

Function

TILING

Allows an image to be expanded and displayed on multiple monitors (up
to 100) through a distribution amplifier.

NOTE

Use a high resolution when tiling an image to multiple monitors.

POWER ON DELAY

Adjusts the delay time between being in Standby mode and entering
Power on mode. The POWER ON DELAY can be set between 0 and
50 seconds.

POWER INDICATOR

Turns on or off the power indicator light. If you select OFF, the power
indicator light doesn’t turn on when the interactive flat panel is in Active
mode.

EXTERNAL CONTROL

Sets the control interface to RS-232C or LAN.

SETTING COPY

Sets the OSD menu categories that copy from the current monitor to
additional monitors that are connected in a daisy-chain configuration.
Setting copy settings reset to default when the interactive flat panel is
turned off.

IMPORTANT
o Set EXTERNAL CONTROL to RS-232C to use this function.

e This function is limited to five additional monitors.

MULTI DISPLAY RESET

Restores the multi-display settings to their default values.

Display protection settings

Menu item

Function

POWER SAVE

Sets how long the interactive flat panel waits to go into Power Save
mode after a lost signal.

NOTE

When you connect a DVI video cable, the video card might not stop
sending digital data even if there is no image. In this case the
interactive flat panel doesn’t enter Power Save mode.

STANDBY MODE

Lowers power consumption.

NOTE
You can't use RS-232C and LAN Functions in Eco Standby mode.
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Menu item

Function

HEAT STATUS

Displays the FAN, BRIGHTNESS and TEMPERATURE settings.

FAN CONTROL

Sets the cooling fan to protect the interactive flat panel from
overheating. When it’s selected, you can adjust the starting
temperature of the cooling fan and its speed.

SCREEN SAVER

Sets a screen saver to reduce the risk of a persistent image.

SIDE BORDER COLOR

Adjusts the color of the borders that appear when a 4:3 image is
displayed.

AUTO BRIGHTNESS

Adjusts the brightness level according to the input signal.
NOTE

You can'’t select this function when the picture mode is set to
AMBIENT1 or AMBIENT2.

CHANGE SECURITY Enables you to change the security password. The preset password is
PASSWORD 0000.

SECURITY LOCK Locks the security password.

DDC ClI ENABLE/DISABLE: turns on or off the two-way communication and

control of the interactive flat panel.

DISPLAY PROTECTION
RESET

Restores the Display Protection settings to their default values.
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Advanced option settings

Menu item

Function

INPUT DETECT

Selects the method of input detection the interactive flat panel uses
when more than two input devices are connected.

INPUT CHANGE

Sets input change speed.
NOTE

When QUICK is selected, the image might be distorted when the
input signal changes.

LONG CABLE COMP

Manually compensates for image degradation caused from using a long
cable.

TERMINAL SETTING

Sets DVI MODE, BNC MODE, SCART MODE and HDMI SIGNAL.

SCAN CONVERSION

Selects the IP (Interlace to Progressive) conversion function.

NOTE
For DVI inputs, set the DVI MODE menu to DVI-HD.

COLOR SYSTEM Sets the color system, depending on the video format of the input
signal.
SCAN MODE Sets the scanning mode. Some video formats might require different

modes to display the best image.

ADVANCED OPTION
RESET

Restores the advanced option settings to their default values.

FACTORY RESET

Restores OSD options to default values for all items, except for DATE
& TIME, LANGUAGE, OSD ROTATION, INPUT NAME, CHANGE
SECURITY PASSWORD, SECURITY LOCK and SECURITY
PASSWORD.
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Hardware environmental
compliance

SMART Technologies supports global efforts to ensure that electronic equipment is manufactured,
sold and disposed of in a safe and environmentally friendly manner.

Waste Electrical and Electronic Equipment
regulations (WEEE directive)

Electrical and electronic equipment and batteries contain substances that can be harmful to the
environment and to human health. The crossed-out wheeled bin symbol indicates that products
should be disposed of in the appropriate recycling stream and not as regular waste.

Restriction of Certain Hazardous Substances
(RoHS directive)

This product meets the requirements of the European Union’s Restriction of Certain Hazardous
Substances (RoHS) directive 2011/65/EU.

Consequently, this product also complies with other regulations that have arisen in various
geographical areas, and that reference the European Union’s RoHS directive.

Batteries

The remote contains a CR 2025 lithium battery. Recycle or dispose of batteries properly.

Perchlorate Material
Contains perchlorate material. Special handling may apply. See
dtsc.ca.gov/hazardouswaste/perchlorate.
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Hardware environmental compliance

Many countries have regulations restricting the use of certain heavy metals in product packaging. The
packaging used by SMART Technologies to ship products complies with applicable packaging laws.

China regulates products that are classified as EIP (Electronic Information Products).
SMART Technologies products fall under this classification and meet the requirements for China’s
EIP regulations.
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